Tutorial on how to write, compile and run a C program in Visual Studio 2012

Go to Visual studio 2012 by using the following path.

Start>All Programs>Microsoft Visual Studio 2012>Visual Studio 2012

g Visual Studio

Before you begin using the application for the first time, you need to specify the type of development
activity you engage in the most, such as Visual Basic or Visual CZ. This information is used to apply a
predefined collection of settings to the development environment that is designed for your
development activity.

You can choose to use a different collection of settings at any time. From the Tools menu, choose
Import and Export Settings and then choose Reset all settings.

Choose your default environment settings:

General Development Settings Description:

JavaScript for Windows 8 Apps Equips the environment with the tools necessary to
LightSwitch Development Settings develop native and managed C++ applications. This
SQL Server Development Settings collection of settings also contains Visual C++ 6 style
Visual Basic Development Settings keyboard shortcuts, among other customizations.

Visual C# Development Settings
Visual F# Development Settings
Web Development

Web Development (Code Only)

Local Help Documentation:

v} i@y Downloads and installs the minimum amount of

Mini =
[ inimum ~ content (about 1 GB).

Start Visual Studio ] [ Exit Visual Studio

Click on ‘Start Visual Studio’. The following window appears on the screen which means
that Visual Studio 2012 is loading and takes some time.

Microsoft Visual Studio

Microsoft Visual Studio is loading user settings. This may take a few minutes.




Alternatively, if Visual studio is already installed in a different environment other than C++,
please go to Tools menu >> Import and Export Settings >> Reset all settings. Follow the
instructions of the wizard and choose C++ as default development environment.
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Welcome to the Import and Export Settings Wizard

Ulti

You can use this wizard to import or export specific categories of settings, or to reset the environment to
one of the default collections of settings.

What do you want to do?

() Export selected environment settings

Settings will be saved out to a file so they can later be imported at any time on any machine.

() Import selected environment settings
Recent Import settings from a file to apply them to the environment.

(® Reset all settings

Reset all envirenment settings to ene of the default collections of settings.

Mext > Cancel
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. Save Current Settings
Ultima
Would you like to save your current settings before you reset?
() Yes, save my current settings

Settings filename:

CurrentSettings-2014-06-02.vesettings

Store my settings file in this directory:

visual studio 2012\settings

chusers\nikhildecuments

Recent

No, just reset settings, overwriting my current settings

< Previous
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Choose a Default Collection of Settings

Which collection of settings de you want to reset to?

£ General Development Settings

£# JavaScript for Windows 8 Apps
{3} LightSwitch Development Settings
£} 50L Server Development Settings
£} Visual Basic Development Settings
£# Visual C# Development Settings
£¥ Visual F# Development Settings
£} Web Development

£} Web Development (Code Only)

Start

< Previous

Cancel

Quick Launch (Ctrl~Q)

Solution Explorer

s

Description:
Equips the environment with the toals
necessary to develop native and managed
C++ applications. This collection of
settings also contains Visual C++ 6 style
keyboard shortcuts, among other
customizations.

Cancel
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After Visual Studio 2012 is loaded, the following screen will be displayed. Click on No.

@

Do you want to download and install
product documentation?

To download and install content, you must have
administrator privileges.

Online Privacy Statement

Yes || No

Following are the steps to be followed to write and compile a C program in Visual Studio
2012. 1. Create an empty project by select [File >> New >> Project]. Type the project name.

Click on File>New>Project

Learn more with these short streaming videos:




2. Select [General >> Empty Project] and type in the project
name. Enter location and name and click ‘ok’.

b Other Languages
b Other Project Types
Modeling Projects

Samples
P Online
Name: Projectl
Location: c\users\vennag5280\documents\visual studio 2012\Projects

Solution name: Projectl

|
B Becent .NET Framework 4.5 ~ Sort by: Default -] &8 Search Installed Templates (Ctrl+E) P~
4 Installed oy X
N ] Empty Project Visual C++ Type: Visual C++
4 Templates . An empty project for creating a local
4 Visual C++ i: Custom Wizard Visual Cis: application
ATL
oy

CLR Ej Makefile Project Visual C++

General

MFC

Test

Win32

LightSwitch

- Browse...

Create directory for solution
[[] Add to source control

oK Cancel

3. Under [Solution Explorer, Source File], right-click and select [Add >> New Item].
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4. Under Code, Select C++ File (.cpp), however, when you type in the name use a program
name with extension .c, such as Source.c and click [Add].

s ~
Add New Item - Projectl ‘j | ® )
4 Installed Sort by: Default - . Search Installed Templates (Ctrl+E) P~

4 VISUSII Gex D‘” C++ File (.cpp) Visual C++ Type: Visual C++
Creates a file containing C++ source code
Gode hﬂ Header File (.h) Visual C
2 ++
HLSL eader File isual
Data OG5 5
e D Midl File (idl) Visual C++
Web
Uttty BB Module-Definition File (.def) Visual C++
Property Sheets
Test -"sl I Component Class Visual C++
Graphics
’Q Installer Class Visual C++
b Online ¥
Name: Source.c
Location: c:\Users\vennag5280\documents\visual studio 2012\Projects\Projectl\Projectl\ - Browse...
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5. You can proceed to type your C program. Click [Save] icon to save your file or press Control-S.
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~Errwes o = -
Search Solution Explorer (Ctri+:) o~ /* this program reads 2 integers and prints the sum. */
fa] Solution 'Projectl’ (1 project) #include <stdio.h>
4 [%] Projectl . . ’
b &3 External Dependencies Elint main(void)
o5 Header Files {

int a, b, sum;

& Resource Files printf( "Input two integers:" );

4 & Source Files scanf( "%d%d",&a,& );
P ++ Source.c sum = a+b;
printf( "\nThe sum of %d and %d is %d\n", a,b,sum );
return @;

} // main




6. To compile the program, under [Solution Explorer, Source File], right click the source file
and select [Compile or (Ctrl+F7)].

N Projectl - Microsoft Visual Studio

4 [%] Projectl

Search Solution Explorer (Ctrl+;)
&1 Solution 'Projectl’ (1 project)

b &3 External Dependencies
o Header Files
& Resource Files

4 &3] Source Files

| o

Open

Open With...

View Code

View Class Diagram
Compile

Scope to This

New Solution Explorer View
Exclude From Project
Cut

Copy

Remove

Rename

Properties

P~

#include <stdio.h>

=int main(veid)

Ctrl+Alt+0

Ctrl+F7

Ctrl+X
Ctrl+C
Del

F2

int a, b, sum;

printf( "Input two integers:" );
scanf( "%d¥d",&a,& );

um = a+b;

eturn @;
/ main

WINDOW  HELP

FILE EDIT VIEW PROJECT BUILD DEBUG TEAM SQL TOOLS TEST ARCHITECTURE  ANALYZE
Q- B - - = | P Local Windows Debugger ~ Auto ~ Debug ~ Win32
@ o-2aBm o (Global Scope)

/* this program reads 2 integers and prints the sum.

x4

A

rintf( "\nThe sum of %¥d and %d is %d\n", a,b,sum );

After compiling the program, the following screen is displayed in the output window.

Output
Show output from: - Burld 5 =%
o e Ouila started: Project: Projectl, Configuration: Oebug wind2
1> Source.c

15¢:\users\vennags280\cocursents\visusl stuaio 2012\projects\projectiiprojectiisource.c(9): warning (4596

15 c:\progras Files (xB8)\microtoft visual studio 11.Mvc\include\stdio.h(298)

essssesans Build: 1 succeeded, @ falled, © up-to-cate, O skipped sssmsssses
|

7. Please note that you cannot run the program until you have built solution.

*seant’:
see declaration of ‘scan

This function or varisble may be unsafe. Consider using scanf_s instend. To cisable deprecation, use
o

8. To build solution select [Build >> Build Solution or (F7)]
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FILE EDIT VIEW
¥ Build Solution
Rebuild Solution

Clean Solution

Run Code Analysis on Solution

% Build Projectl

Clean Projectl
Project Only

PROJECT

BUILD
F7
Ctrl+Alt+F7

DEBUG

Alt+F11

Profile Guided Optimization

Batch Build...

Configuration Manager...

2l

Compile

Ctrl+F7

TEAM

3 Rebuild Projectl

SqQL
Windows Debugger ~ Auto

o s-.coc = <

(Global Scope)

TOOLS  TEST

ARCHITECTURE

Debug

ANALYZE

Win32

WINDOW

HELP

A
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#include <stdio.h>

=lint main(void)

[{

int a, b, sum;

printf( "Input two integers:™ );
scanf( "%d¥%d",%a,& );

sum = a+b;

printf( "\nThe sum of %d and %d is %d\n", a,b,sum );

return 0;
L}y // main



9. To run the program without debugging, select [Debug >> Start without debugging or
(Ctrl+F5)]. (Note: If you do not have this option, you need to add the command manually
under Tools >> Customize. You may add a menu option or a button in the Debug toolbar.)
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; Windows * Hows Debugger ~ Auto ~ Debug ~ Win32 - | A S
: Graphics > =
; Sourcec # X
3 P Start Debugging F5 (Global Scope)
: P Start Without Debugging Ctrl+F5 #include <stdio.h>
. & Start Performance Analysis Alt+F2
. 1 Start Performance Analysis Paused Ctrl+Alt+F2 —}.nt main(ioid)
! aﬁ’ Attach to Process... int a, b, sum;
! Exceptions... Ctrl+Alt+E printf( "Input two integers:" );
! scanf( "%d%d",&a,& );
' G Steplnto F11 sum = a+b;
: (.) Step Over F10 printf( "\nThe sum of ¥d and %d is %d\n", a,b,sum );
return @;
} // main
New Breakpoint »
IntelliTrace »

Import DataTips ...

‘ Options and Settings...
3 & Projectl Properties...

10. For any runtime error, you can debug the program as follows; Select [Debug >>
Start debugging (F5)].

e i i e o-------=-
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, FILE EDIT VIEW PROJECT BUILD DEBUG TEAM SQL TOOLS TEST ARCHITECTURE ANALYZE WINDOW  HELP

! Windows * Jows Debugger ~ Auto ~ Debug ~ Win32 - A LI B B [
: Graphics > b=
; Sourcec B X
P Start Debugging F5 (Global Scope)
! P Start Without Debugging Ctrl+F5 #include <stdio.h>
B Start Performance Analysis Alt+F2
| [ Start Performance Analysis Paused Ctrl+Alt+F2 T Ent 21 (%036)
: & Attach to Process... int a, b, sum;
: Exceptions... Ctrl+Alt+E printf( "Input two integers:" );
: scanf( "%d%d",&a,& );
' 6o Steplnto Fi1 sum = a+b;
i & Step Over F10 printf( "\nThe sum of %d and %d is %d\n", a,b,sum );
' return @;
i } // main
New Breakpoint ’
IntelliTrace »
Import DataTips ...
Options and Settings...
#  Projectl Properties...

Note: Please note that during debugging, the program will show and close the console
display immediately. To see the console display, you must run without debugging.



11. After you are done completing the project. First go to the drop down menu near the top of
the screen which says “debug” and change it to “Release” in order to save your project as .exe

(as shown)

e

D Project! - Microsoft Visual Studio
' FILE EDIT VIEW PROJECT BUILD DEBUG TEAM SQL TOOLS TEST ARCHITECTURE ANALYZE WINDOW HELP

o - B - e P Local Windows Debugger ~ Auto ~ Debug Win32 - A
: Debu
: Solution Explorer ; v B X Sourcec # X Relea?e
B o-2aiEm © ﬁ@l (Global Scope) Configuration Manager...
i Search Solution Explorer (Ctrl+;) o~ /* this program reads 2 integers and prints the sum. */
;] Solution 'Projectl’ (1 project) #include <stdio.h>
. 4 [%] Projectl i . .
: b &3 External Dependencies T ”{'"t main(void)
=5 Header Files e
i int a, b, sum;
= Resource.Flles printf( "Input two integers:" );
4 &l SourceFiles scanf( "¥d%d",&a,8 );
P ++ Source.c sum = a+b;
printf( "\nThe sum of %d and %d is ¥d\n", a,b,sum );
return @;
} // main

12. Go to the Build menu and select “Rebuild”.This should give the similar output.

3 M Projectl - Microsoft Visual Studio
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: % Build Solution F7 Windows Debugger ~ Auto ~ Debug ~ Win32 - | A
! Rebuild Solution Ctrl+Alt+F7
. X Sourcec B X
) ! luti
: Clean Selution . ' (Global Scope)
. Run Code Analysis on Solution Alt+F11 o - * this program reads 2 integers and prints the sum. */
! &% Build Projectl
: #include <stdio.t
! Rebuild Projectl e
Clean Projectl -lint main(void)
Project Only » {
int a, b, sum;
Profile Guided Optimization » printf( "Input two integers:" );
Batch Build... scanf( "¥d¥%d",&a,& );
7 X sum = a+b;
! Configuration Manager... printf( "\nThe sum of %d and %d is %d\n", a,b,sum );
; ?ﬁﬂ Compile Ctrl+F7 r“e.turrj 2;
; } // main

Go to Windows Explorer and go to:

Application or .exe file location: “C:\Documents and Settings\your_username
_here\My Documents\ Visual Studio2012\Projects\Project_name\Release”. Double
click on the filename.exe(Eg.Code.exe),check if it runs.

Source code file location:“C:\Documents and Settings\your _username_here\My
Documents\ Visual Studio2012\Projects\Project_name\ Project_name”.

You need to hand in source code of your project.
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For the console not to be closed automatically, the following steps need to be followed:

1. Open up your project, and go to the Solution Explorer.
2. Right click on your project name.

3. Choose "Properties" from the context menu.

______________________________________________________________________________________________________________________ ————————————————————
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/* this program reads 2 integers and prints the sum. */

he sum of %d and %d is %d\n", a,b,sum );
New Solution Explorer View

Profile Guided Optimization 4

i Search Solution Explorer (Ctrl+;) poRd

i Rad Solution 'Projectl’ (1 project) #include <stdio.h>

B Projectl

: b &3 Extemnal Depend ki Build

] 58 Header Files Rebuild L

| = seswr:f'les g ut two integers:” );
' 4 &l SourceFiles Project Only » 4",8a,8b );

; b ++ Source.c

; Scope to This

Calculate Code Metrics

Build Customizations...

Add »
References...
Class Wizard... Ctrl+Shift+X
Manage NuGet Packages...

View Class Diagram

& BE

Set as StartUp Project
Debug »
Add Solution to Source Control...

Cut Ctrl+X

Remove Del

X OoxE

Rename F2
Unload Project

Rescan Solution

Open Folder in File Explorer

Properties
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4. Choose Configuration Properties>Linker>System.

Projectl Property Pages 2| =

Configuration: [Active(Release) V} Platform: [Active(WinBZ) 'J [ Configuration Manager... ]

> Common Properties SubSystem

4 Configuration Properties
General
Debugging
VC++ Directories
C/C++
4 Linker
General
Input
Manifest File
Debugging
System
Optimization
Embedded IDL
Windows Metadata
Advanced
All Options
Command Line
Manifest Tool
XML Document Generator
Browse Information
Build Events
Custom Build Step
Code Analysis

Minimum Required Version
Heap Reserve Size

Heap Commit Size

Stack Reserve Size

Stack Commit Size

Enable Large Addresses
Terminal Server

Swap Run From CD No

Swap Run From Network No

Driver Not Set
SubSystem

The /SUBSYSTEM option tells the operating system how to run the .exe file.The choice of subsystem affects the

entry point symbol (or entry point function) that the linker will choose.

[ ok

][ Cancel ] Applh




5. For the "Subsystem" property in the right-hand pane, click the drop-down box in the right

hand column.

Projectl Property Pages

Configuration: [Active(Release)

~| Platform: [Active(Win32)

'] [ Configuration Manager... J

> Common Properties [=]
4 Configuration Properties Minimum Required Version Not Set
General Heap Reserve Size Censole (/SUBSYSTEM:CONSOLE)
Debugging Heap Commit Size Windows (/SUBSYSTEM:WINDOWS)
VC++ Directories Stack Reserve Size Native (/SUBSYSTEM:NATIVE)
p C/Ce+ Stack Commit Size EFI Application (/SUBSYSTEM:EFI_APPLICATION)
4 Linker Enable Large Addresses EFI Boot Service Driver (/SUBSYSTEM:EFI_BOOT_SERVICE_DRIVER)
General Terriinial Server EFI ROM (/SUBSYSTEM:EFI_ROM)
}c‘:::fest - Swap Ruri From CD gg;;ntlme (/SUBSYSTEM:EFI_RUNTIME_DRIVER)
3 Swap Run From Network (/SUBSYSTEM:POSEX)
Debugging Driver Not Set
System
Optimization
Embedded IDL
Windows Metadata
Advanced
All Options
Command Line
> Manifest Tool
> XML Document Generator
> Browse Information
1> Build Events
(> Custom Build Step
> Code Analysis SubSystem
The /SUBSYSTEM option tells the operating system how to run the .exe file.The choice of subsystem affects the
< T » entry point symbol (or entry point function) that the linker will choose.
[ OK ] [ Cancel ] |  Apply
6. Choose "Console (/SUBSYSTEM:CONSOLE)"
2| =

Projectl Property Pages

Configuration: [Active(Release)

v] Platform: [Active(W in32)

V] [ Configuration Manager... ]

> Common Properties
4 Configuration Properties
General
Debugging
VC++ Directories
p C/C++
4 Linker
General
Input
Manifest File
Debugging
System
Optimization
Embedded IDL
Windows Metadata
Advanced
All Options
Command Line
> Manifest Tool
> XML Document Generator
> Browse Information
> Build Events
» Custom Build Step
> Code Analysis

Minimum Required Version
Heap Reserve Size

Heap Commit Size

Stack Reserve Size

Stack Commit Size

Enable Large Addresses
Terminal Server

Swap Run From CD

Swap Run From Network
Driver

[=]

Not Set
Console (/SUBSYSTEM:CONSOLE)

Windows (/SUBSYSTEM:WINDOWS)

Native (/SUBSYSTEM:NATIVE)

EFI Application (/SUBSYSTEM:EFI_APPLICATION)
EFI Boot Service Driver (/SUBSYSTEM:EFI_BOOT_SERVICE_DRIVER)

EFI ROM (/SUBSYSTEM:EFI_ROM)

EFI Runtime (/SUBSYSTEM:EFI_RUNTIME_DRIVER)

POSIX (/SUBSYSTEM:POSIX)

Not Set

SubSystem

The /SUBSYSTEM option tells the operating system how to run the .exe file.The choice of subsystem affects the

entry point symbol (or entry point function) that the linker will choose.

OK ] [ Cancel ] ‘ Apply

7. Click Apply. Wait for it to finish doing whatever it does, then click OK. (If "Apply" is grayed out,
choose some other subsystem option, click Apply, then go back and apply the console option.)



